
Welcome to WindowShine! 
Welcome to WindowShine, the latest in a series of exclusive Windows User utilities designed specifically 
for our readers. We hope that you'll find WindowShine an invaluable tool for streamlining and maintaining 
your Windows system. 

The program, designed and written by Mark Stephens and Sean Geer, is intended to be a flexible tool for 
doing just about anything you can think of in the Windows environment. We've included some sample 
modules for you to use immediately, and we'll shortly release some of the technical specifications so that 
third parties can write more extensions to WindowShine. We'll be periodically issuing new modules on 
cover disks throughout the rest of this year.

WindowShine is very broad in its scope. The modules we've included here are basic system-level utilities,
but there are lots of other potential applications - icon editors, file viewers, even small spreadsheets - 
which would slot well into WindowShine. We'd be pleased to hear any bright ideas readers have about 
future modules or enhancements to the program. 

Please read the rest of this help file for more information on what WindowShine is and how it works.

Now read on:
Before you start 

What's In WindowShine? 

Using the help system 

See also:
About Windows User Disclaimer! 



What's In WindowShine? 
WindowShine is a very flexible tool for managing your Windows environment. It's based on individual 
modules , each of which is devoted to performing a specific function such as editing INI files or launching 
applications. Each module consists of one or more elements - in the case of the INI Editor, for example, 
these consist of separate parts for WIN.INI and SYSTEM.INI as well as a general INI editor - which are 
shown as individual tabs  within the main WindowShine window. Clicking on a tab brings it to the top of 
the pile and allows you to use its features.

The main program consists of a standard title and menu bar, together with a self-configuring toolbar . The 
toolbar displays buttons only for those modules installed on the system; similarly, the View menu lists only
installed modules. The main window is used to display the contents of each WindowShine module. Only 
one module may be displayed at a time, although you may have up to twenty installed on the system, and
each module can display a maximum of fifteen tabs. To install new modules, you use the Module 
Manager ; this copies the right files to your WindowShine directory and updates the SHINE.INI file in your 
Windows directory.

Now read on: See also:
Windows Basics More about modules 

System Basics Working In WindowShine 

INI Editor Using this help system 

Program Launcher 

System Optimiser 



The Module Manager 
To install new modules into WindowShine you use the Module Manager. To run it, choose Modules... from
the Edit menu. You'll see the dialog box below, which you use to browse for the drive and directory 
containing new DLLs. Press Add... to bring up the browse dialog or Delete to remove the currently 
highlighted module. The Manager automatically copies modules to your WindowShine directory and 
updates SHINE.INI.

Note that WindowShine only allows DLLs written specifically for it to be installed. If you attempt to install a
DLL that is not WindowShine-specific you'll get an error message.



More about modules 
A WindowShine module consists of a DLL with some special characteristics that allow it to display its 
functional components within WindowShine's tab-based architecture. While the DLL must contain certain 
resources in order to do this, there are no restrictions on what sort of functionality a module can have. 
This means that WindowShine can be extended to do lots of different things, limited only by the display 
area available. 

There's also no theoretical limit to the number of modules you can install in WindowShine, although 
above about twenty you'll start running out of space on the toolbar and the View menu will become pretty 
unmanageable. Right now, there are only five modules anyway - the ones on the April cover disk - but this
should change once the WindowShine API is published and third parties start to write their own modules.

If you've got any bright ideas about interesting uses to which WindowShine modules might be put, write to
Windows User's editor at the following address:

Windows User
Quadrant House
The Quadrant
Sutton
Surrey SM2 5AS

We'll try to use as many of your suggestions as we can on forthcoming cover disks. 



popups 



toolbar 
The WindowShine toolbar looks like this. Clicking on a button 
switches between modules.



tabs 
Tabs are the mechanisms used to display separate module elements in WindowShine. 
Clicking on a tab brings it to the fore and displays its information.



module 
A program element in WindowShine that performs a number of related tasks. Each module is represented
by a collection of tabs displayed in the main window. Five modules are supplied with the initial release of 
WindowShine - system information, Windows information, INI editor, program launcher and system 
optimiser.
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About Windows User 
Windows User, from Reed Business Publishing, was the first newstand magazine devoted solely to all 
things Windows. Each month, Windows User analyses news from the world of Windows, reviews major 
new hardware and software products and provides a wealth of background information for Windows users
everywhere.

Windows User is well known for the quality of its in-depth reviews and for its coverage of Windows 
hardware. A thriving question-and-answer section and the innovative Points & Clicks and Workbench 
pages serve to make Windows computing easy and fun for all our readers.

Windows User also runs a conference on the CIX on-line service - at the prompt type join windows_user. 
This is an open conference where readers and the Windows User team can discuss issues arising from 
the magazine, swap ideas and explore some of the cultural issues surrounding Windows. In addition we 
try to deal with readers' technical problems, and shareware programs, macros and hints and tips are 
regularly uploaded to the file area.

Contact Windows User at:
Quadrant House
The Quadrant 
Sutton 
Surrey SM2 5AS

Editorial Tel: 081-652 3662. Fax: 081-652 8943
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Using this help system 
Some hints for using this help system:

      Press F1 to bring up the help file for any module.
      To get help on the main WindowShine program, select Contents from the Help menu
      Clicking on a button like this        

      in any of the help files takes you back to the main WindowShine help system.
      Icons like this      

      are just for decoration.
      Clicking the Contents button in any of the module help files takes you back to the first page of that 

file.
      Words underlined like this... 
      When you see a word highlighted like this , click it for more information or a picture.
      Check the About Windows User  topic for details of subscribing to and contacting the magazine.



Warning! 
Many of the modules in this program are diagnostic only - that is, 
they don't make any changes to your system. However, the INI 
Editor and the System Optimiser are both capable of making 
changes to your system files and must therefore be used with 
caution. You MUST read the appropriate entries in this help file 
before using either of these modules. WindowShine will 
automatically back up your most important system files, but you are
strongly advised to back these up manually before proceeding.

Click anywhere on the screen to continue.



DISCLAIMER 
Every possible effort has been made to ensure that the programs 
on this disk will run correctly, but neither Windows User nor Reed 
Business Publishing can guarantee that programs will run and can 
accept no responsibility for any errors in the software, or for any 
consequences of any users' actions taken or not taken as a result 
of using this software. Users are strongly advised to make 
appropriate backups of their software before installing or running 
any of these programs.



Before you start 
The first time you ran WindowShine, it automatically backed up your four most important system files - 
AUTOEXEC.BAT, CONFIG.SYS, WIN.INI and SYSTEM.INI - to the directory in which you installed the 
program. Each file has been given the extension .WSH. We strongly recommend that you copy these files
to a floppy disk and keep them somewhere safe.

The System Optimiser  module will make some additional backups when you run it - see the System 
Optimiser help file for more details. 

Now read on:
What's In WindowShine? 



Working In WindowShine 
WindowShine is very easy to use, thanks to its tab-based structure. Each module's tabs can be activated 
either by clicking on the tab itself, which brings it to the foreground, or by using the keyboard. To activate 
a tab with the keyboard, press Ctrl + Shift + Letter, where Letter is the underscored letter in the title on 
each tab.

You can switch between modules in two ways, too. Either select the module you want to use from the 
View menu, or press the appropriate button on the toolbar . The menu and toolbar are both self-
configuring - every time you install a new module with the Module Manager  the menu and toolbar will be 
updated accordingly, and appropriate entries made to SHINE.INI  (located in your Windows directory).

If you're not sure which module you're currently in, look at the title bar .



SHINE.INI 
SHINE.INI is a text file used by WindowShine to store configuration information. In addition to storing a list
of installed modules, it also includes sections specific to each module, such as current directory 
information.

WARNING: Be very careful when modifying SHINE.INI, as you may not be able to run the program 
satisfactorily if you make a mistake. In general, it's best to let WindowShine modules make changes for 
you; always use the Module Manager  to add or delete new modules, and use a plain text editor or the 
WindowShine INI Editor if you really need to make other changes.



... jump to another topic. Press the button to go back:      

Or click here >     to find out more about WindowShine.



INI file 

An inititialisation file used by Windows or applications for configuration purposes



display driver 

A piece of software specific to a graphics card or processor that controls the drawing of on-screen 
elements in Windows. High-quality display drivers are very important for gaining good graphics 
performance under Windows.



printer driver 

A hardware-specific piece of software that determines how Windows and applications print. Good printer 
drivers are very important in ensuring acceptable print quality under Windows - make sure that you get 
the latest one for your printer from the supplier or a bulletin board service such as CIX.



DOS 

Disk Operating System. You need one of these, preferably a Microsoft version, to run Windows.



CIX 

Compulink Information Exchange. An online service providing a forum for discussions of many kinds, and 
a good source of Windows information and software. Call 081-390 8446 to find out how to subscribe. 
You'll need a modem, some comms software    and an anorak. 



system resources 

Internal resources used by the Windows system for creating internal structures such as windows, fonts, 
and other much hairier stuff. If you run out of them your apps will die and your shell may fry, irrespective 
of available memory. Close everything down and restart Windows when they get below about 25% (check
with WindowShine!).



Version Viewer 

A WindowShine utility for checking file versions and information. It's in the Windows Basics module.



BIOS 

Basic Input/Output System. An important part of your computer which manages hardware and software 
interactions, among other things. You shouldn't have to worry about this very often.



SYSTEM.INI 

An initialisation file used by Windows to determine which hardware and software drivers it must load as it 
starts. Don't mess with it unless you're sure what you're doing - a missing or corrupt SYSTEM.INI will stop
Windows working altogether.



CONTROL.INI 

Control Panel's initialisation file, responsible for storing information on colour schemes, screen savers, 
multimedia devices, patterns and more.



WINFILE.INI 

File Manager's initialisation file, responsible for managing user options such as confirmation settings, 
saving directory information and managing add-ons.



PROGMAN.INI 

Program Manager's initialisation file, responsible for managing group information, saving user options 
and, if you know the right tricks, preventing access to some of ProgMan's customisation features.



.DLL 

The extension for Dynamic Link Library files, which both the system itself and applications use for storing 
resources, program code and much else. Your \WINDOWS\SYSTEM directory will be full of these - don't 
delete them unless you're SURE you don't need them. You can use Version Viewer to see where most of 
them come from.



.EXE 

The extension for Windows' executable files - the ones you use to run programs.



.DRV 

The extension for Windows device drivers, bits of software that act as a bridge between Windows and 
hardware items. Graphics cards and printers need them - so do most other bits of hardware in your 
system, especially sound cards and other multimedia devices.



.FON 

The extension for Windows' bitmapped font files, as used by display drivers for displaying fonts on menus
and window title bars.



.386 

The extension for Windows virtual device drivers, special bits of software needed for Windows and apps 
to talk directly to hardware elements. 



TrueType 

A system built into Windows allowing applications to display and print scaleable typefaces. Needs 
TrueType fonts to work.



Adobe Type Manager 

A font management system, similar to TrueType but using PostScript fonts instead. Favoured by 
professional DTPers.



WindowShine 

A utility from Windows User for helping to streamline your Windows system.



Mark Stephens 

A propellerhead. He wrote WindowShine.



gloss 



Windows Resource Kits 
The Windows Resource Kits, produced by Microsoft, are full of information about managing and 
configuring Windows. In addition to containing very detailed explanations of how Windows works and how
to optimise its peformance, they include mountains of information not included in the standard Windows 
documentation. Separate version are available for Windows 3.1 and Windows for Workgroups. They cost 
£25 + £6.60 P&P: to get hold of a copy, call the Microsoft Upgrade Centre on 081-614 8000.
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